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1. Background
Monitoring of lung function in at-risk populations enables the identification of
individuals with excessive decline of lung function. The spirometry test of forced
expiratory volume in one second (FEV1) is the measure best suited for monitoring
changes in lung function over time. An excessive decline in FEV1 over several years can
indicate development of lung disease and has been shown to be associated with increased
respiratory morbidity, loss of productivity at an earlier age, and increased mortality.1-5
The Spirometry Longitudinal Data Analysis (SPIROLA) software is an integrated visual
and quantitative tool to aid in monitoring lung function in individuals participating in
spirometry-based health monitoring programs. To ensure that individuals with excessive
decline in lung function can be identified accurately and in timely manner, it is important
to maintain acceptable quality of the spirometry tests6 and precision of the longitudinal
spirometry data.7 For that purpose, SPIROLA enables the user to monitor spirometry
tests’ quality grades and longitudinal data precision for a monitoring program. This
monitoring also provides a basis on which to determine an appropriate limit of
longitudinal decline in individuals.8-9 SPIROLA may help to preserve lung function
through identification of individuals with excessive decline followed by appropriate
intervention. The intervention function helps to obtain information on potential risk
factors, and plan, record, and evaluate the effect of intervention strategies. The
questionnaire function helps to conduct questionnaire surveys of workers.
SPIROLA provides the following functions:
For an individual evaluation:
• It monitors the level of FEV1 and FVC in relation to criteria for assessment of crosssectional data: the lower limit of normal (LLN) (i.e., the lower 5th percentile) and the
lower 0.1th percentile (approximately comparable to 60% predicted).
• It monitors FEV1 and FVC change over time in relation to criteria for assessment of
longitudinal changes: the limit of longitudinal decline (LLD).
• It provides interpretation of the rate of FEV1 and FVC decline and data variability in
an individual’s summary report and suggests actions to prevent further excessive loss.
• It enables to plan, record, and evaluate intervention measures.
For a group evaluation:
• It provides a screening function “Risk List” that helps to screen for individuals whose
lung function level, decline, or variability may be abnormal, and provides statistics on
the number of individuals screened and with various abnormalities.
• It monitors group means for FEV1 and FVC (observed, predicted and z-score) to
enable the user to identify time-related changes taking place at a group level. The
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group means can be monitored for all participants, or for sub-groups selected by Risk
List, i.e., those with certain abnormalities or participants undergoing intervention.
It monitors longitudinal FEV1 and FVC data precision using the pair-wise estimate of
within-person variation sp (absolute) or sr (relative).6-8 This function helps to identify
changes in data variability that may be due to changes in testing procedures (e.g., a
new spirometer, technician, or healthcare provider) or effects of exposure.
It helps to monitor the percentage of spirometry testing sessions that do not meet the
2005 ATS/ERS criteria for acceptability and repeatability, overall and by a
technician.
It enables the user to conduct a computerized questionnaire survey.
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2. SPIROLA Installation
SPIROLA runs on PC with Microsoft Windows system, see Appendix A for details.
1. Open NIOSH SPIROLA webpage
https://www.cdc.gov/niosh/topics/spirometry/spirola-software.html.
2. Click on SPIROLA V 3.0.3 link to download SPIROLA.
3. Extract the contents of the Zip file to a temporary folder (e.g., C:\SpirolaSetup). Run
the setup.exe file to start the installation.
4. Follow instructions specified by the installation procedure. User needs to read and
agree with a DISCLAIMER to install and use the software. Click Next> to proceed.
5. The Select Installation Folder window will appear, as shown below. By default,
SPIROLA is installed into C:\Program Files\SPIROLA folder. If a user does not
have security permissions to install on the Program Files, an alternative location can
be specified (e.g. c:\SPIROLA, My Documents or Desktop). Click Next> to proceed.

6. Follow the setup wizard instructions to complete the installation. On completion, an
Installation Complete window will display message “SPIROLA has been
successfully installed”. Click Close to exit.
7. SPIROLA item will be added to the All Programs menu on the Windows Start
menu, and a SPIROLA icon will be created on the Desktop.
8. If SPIROLA is being uninstalled by the user for an update, and if Intervention and
Questionnaire menus have been used, the user should create a back-up copy of the
administrative database, SPIROLA_Admin.mdb, in a safe location (see Section 9).
SPIROLA Ver. 3.0.3
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2.1 Start and close SPIROLA
To run SPIROLA using a demonstration database:
1. Double click the SPIROLA icon from the Desktop, or start the SPIROLA program
via Start > All Programs > SPIROLA to open SPIROLA.
2. On the File menu click on Open Database and on Open MS Access Database (see
below).
3. In the next window open DemoDataSet.mdb database located in the same folder as
SPIROLA (see Section 3 for more details).
4. To test SPIROLA, view individual charts using the Individual Evaluation menu.
5. To close SPIROLA, on the File menu click Exit, or just click the close button in the
right upper corner of the window.
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3. SPIROLA Databases: Requirement and Management
3.1 Required Databases
SPIROLA requires a spirometry database of a specific format (see Section 3.2). Initially,
the user can create an empty spirometry database of the required format (see Section 3.3)
and type or import into it the required data. The user can also create an automatic link to
an existing spirometry database created by a spirometer or medical record database that
contains spirometry data (see Section 3.4). To see an example of SPIROLA database, the
user can open and view the demonstration database “DemoDataSet.mdb” stored in the
same folder as SPIROLA. For management purposes, SPIROLA automatically creates an
administrative database, “SPIROLA_Admin.mdb”, to store information it needs to
remember, mainly intervention and questionnaire survey data (see Section 9).
The following types of databases can be used to store the spirometry data:
• Microsoft Access databases (See Appendix A)
• Microsoft Excel files
• Text files
• Microsoft SQL Server databases
• Any other type of database for which ODBC (i.e., Open Database Connectivity)
driver is installed on the workstation on which SPIROLA is installed.

3.2 Spirometry Database Format
Each record in the spirometry database should contain unique identity information (ID) to
identify a participant, demographics (sex, race, height, age or birth date), and information
on a single spirometry test; see essential and optional fields (variables) listed below. The
variables’ names need to conform to the names specified below, but are not case
sensitive. The variables can be in any order. Databases sorted by ID and date of test
(TestDate) will be processed faster.
The default input format for dates, heights, lung function values (i.e., FEV1, FVC) and
the values for gender and race as shown below can be changed (see Section 3.4, Change
data input format) to reflect the original data format.
The following variables are essential (must be included):
• ID – A text field (alpha numerical) to uniquely identify an individual. To speed up the
data processing, a numerical ID field is preferable, but it is not a requirement.
• Sex – A text field to store “M” for male or “F” for female gender.
• Race – A text field to store “M” or “I” for Mexican-Americans, “B” or “A” for
African-Americans, or “W” or “C” for Caucasians and “S” for AsianAmericans. This variable is used for selecting the appropriate set of reference
equations.
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• Age – A numerical field for age in years at a test (optional if date of birth provided).
• BirthDate – A date field (format: mm/dd/yyyy) to store date of birth (optional if age
is provided). This field allows more accurate calculation of age, (e.g., 45.5 vs. 45).
• Height – A numerical field to store height (cm) measurements of a tested individual
• FEV1 – A numerical field to store best FEV1 (mL) value from a test.
• FVC – A numerical field to store best FVC (mL) value from a test.
• TestDate – A date field (format: mm/dd/yyyy) to store test dates.
The following variables are optional for spirometry quality analysis:
•
•
•
•
•
•
•

FEV12 – A numerical field to store second best FEV1 (mL) value.
FVC2 – A numerical field to store second best FVC (mL) value.
QFEV1 – A character variable for FEV1 quality grades (if available).
QFVC – A character variable for FVC quality grades (if available).
QTest – A character variable for session quality grades (if available).
Oper – A character variable for operator (spirometer technician) code or name.
Provider – A character variable for a provider (e.g., a van service).

The following name variables are optional and are needed for a search by name:
• Last_Name – A text field (Surname/family name).
• Middle_Initial – A text field (leave blank if not available).
• First_Name – A text field.
Inclusion of names in the database enables the user to identify an individual by name
using Search for a Participant function in the Individual Evaluation menu. If both
Last_Name and First_Name are provided, the reports will include the names.
Additional fields containing, for example, weight, smoking status, cigarettes/day, asthma
status, or respiratory symptoms data can be added. These data will be shown with the
individual’s FEV1 chart, but will not be used in the analysis.
TROUBLESHOOTING: If individual charts do not appear, the first step is to check that
the format and units of the essential variables are correctly defined. If the format differs
from the one provided above, for example height is in inches, use Change data input
format (Section 3.4) to define the correct data input format.

3.3 Create an Empty SPIROLA Database
An easy way to start learning how to use SPIROLA is to create an empty SPIROLA
database, type or import sample data into the database, open it in SPIROLA (see Section
3.4 below) and try SPIROLA’s various functions.
1. On the File menu click on Create Empty Database.
2. Click on the menu item with the preferable database, Empty Microsoft Access
Database or Empty Excel File (see below).
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3. In the window which appears next (see below), name the database and assign its
location.
4. Click OK and follow the link to open the newly created file.

5. Right click to Open the database and right click to Open one of the two tables:
Standard (contains essential variables) or Full (includes also optional variables).
6. To import data into the SPIROLA database see Appendix G.
Note: Because SPIROLA reads MS Access database directly (see Section 3.4 below),
this database is preferable. Alternatively, the user can create an Excel database and
import it into MS Access, or use the ODBC Menu (see below) to connect to the Excel file
with SPIROLA application (see Appendix E: Create ODBC data source for Excel 2007).

3.4 Open and Manage Spirometry Database
To open SPIROLA dataset click on File menu and then on Open Database, see below.
Once a database is specified, SPIROLA will remember the database address until the user
specifies another database address.
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The Open Database menu allows the user to open the following types of databases:
a) Open MS Access Database menu opens Microsoft Access database. A file dialog
window will appear (see the picture below), where the user should select the MS
Access file (for example DemoDataSet.mdb, see below) and click Open to proceed.
For demonstration purposes SPIROLA package includes MS Access database
“DemoDataSet.mdb” installed in the same folder as SPIROLA (e.g., C:\Program
Files\SPIROLA\ DemoDataSet.mdb).
b) Open ODBC Database menu opens the following databases: Microsoft Excel files,
text files, SAS files, Oracle databases, and other databases supported by the ODBC
system. If the database is not a Microsoft Access database or Microsoft SQL Server
database select Open ODBC Database menu (see Appendix B: Open different types
of spirometry datasets).
c) Open SQL Server Database opens Microsoft SQL Server database (Appendix B).
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Types of databases SPIROLA can open
(i) Databases in a tabular format, where all records are stored in a single table (e.g., MS
Excel or Access files), and all essential variables are included (see Section 3.2).
(ii) Databases for which converter software Spirola data provider is installed, which
enables SPIROLA to read data from other types of databases (e.g., databases created
by spirometers). Spirola data providers have the following characteristics:
a. They are DLL or EXE extension files which convert data in a spirometry
database to a database which has a SPIROLA required format (see above).
b. They can be programmed using any .NET programming language, such as
C#.NET or VB.NET.
c. Their installation is easy, and usually involves copying the data provider file
(i.e., DLL extension file) to a specific directory. See Appendix D for details.
d. Spirola data providers already installed in SPIROLA include:
SpirolaDataProviderDemo.dll, EasyOneSpirolaDataProvider.dll,
KeystoneSpirolaDataProvider.dll, and OMISpirolaDataProvider.dll.
SpirolaDataProviderDemo.dll data provider can be used to open the demo
database SpirolaDataProviderDemo.mdb, which comes with SPIROLA.
The other three providers can be used to open databases generated by
EasyOne, Keystone, and OMI spirometers.

Select a subset from spirometry database
By default SPIROLA will load the whole dataset. To select a subset of individuals whose
first test and/or last test are within a specified period, click on Select Data Subset and
select the appropriate period for the first test or for the most recent test (see below). If the
checkbox next to Select Data Subset button is not checked, it means that no subset is
selected. This function is useful for selecting individuals tested within recent years.

Change data input format
To change the default input format (see above), click on the Select Data Input Format.
The date input format can be change to the dd/mm/yyyy, dd-mm-yyyy or dd.mm.yyyy.
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The format for height can be in inches or centimeters, and lung functions can be read in
liters or milliliters. The race value is used to select an appropriate reference equation. In
the example below, SPIROLA will apply White as a default race when race value is
missing. The user can change Race input values under Race and Value 1 to Value 3 for
White, Black, Mexican-American, and Asian-American race/ethnicity corresponding to
US reference equations provided by default.

Select reference equation
At this stage, spirometry reference equations can be selected out of three sets of reference
equations: US population reference equations, European population reference equations,
and custom reference equations. Note, the custom reference equations can be changed
later by clicking on the Options menu and Reference Equations (Section 8.4 Crosssectional evaluation—Customize reference equations).
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Re-load database and obtain database information
After the spirometry data is loaded into SPIROLA from the database, it is possible that
new test results are added to the database, or existing test results are modified. The menu
File > Reload can be used to quickly reload spirometry data into SPIROLA (see below).

1. Click on All test results to reload all test results into SPIROLA.
2. Click on New test results, taken on or after “Date when SPIROLA was opened”
to quickly load test results taken on or after date when SPIROLA was opened. To
include test results taken before SPIROLA was opened click on All test results.
To obtain database information, on the File menu, click on Opened Database Info, to
display information about the currently opened database (see below).

Open or locate administrative database
Administrative database SPIROLA_Admin.mdb, contains information that SPIROLA
needs to remember while processing the spirometry data. Also, the administrative
database stores permanently information created using the Intervention and
Questionnaire menus. When Intervention or Questionnaire menus are used, then the
administrative database should be kept in a secured location that is regularly backed-up
(see Section 9). The same applies to the SPIROLA spirometry database.
SPIROLA Ver. 3.0.3
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4. Spirometry Data Evaluation and Screening
4.1 Group Selection Menu
By default all participants are evaluated. To view observations identified to have invalid
data, click on Group Selection and Participants with Invalid Data. Values that are not
valid are shown in red. To view individuals previously selected by the Risk List function,
click on Participants in Risk List. To view participants with duplicate records, click on
Participants with Duplicate Data. To restore to default, click on All Participants. . If
needed, correct the values in the original database or in the SPIROLA MS Access
database.

4.2 Individual Evaluation Menu
The Individual Evaluation menu lists evaluations that can be done on an individual.

Monitor FEV1 in an individual
1. On the Individual Evaluation menu click FEV1 Evaluation to show a FEV1 chart.
2. Click the arrow next to combo box (ID box) on the left bottom corner to select the ID.
Alternatively, select a participant using the Search for a Participant menu (see
above); see Section Search for an individual by name or identity number below.
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The individual FEV1 chart shows: the observed FEV1 values (green dots) plotted against
age; the linear regression line (green line) fitted to the observed FEV1 data when at least 4
years of follow-up data are available; cross-sectional lower limit of normal (LLN), i.e.,
the lower 5th percentile (purple line) and the lower 0.1th percentile (comparable to 60%
predicted) (orange line). The percentiles help to determine the probability with which an
observed value is likely to occur in the reference population. U.S. population-based
reference equations are used by default,7 but user can specify own equations (see Section
8). The blue solid line represents the limit of longitudinal decline (LLDr) calculated from
the baseline observation(s). The default LLDr is based on ≈10% annual decline, i.e., the
default relative within-person variation of 4% and reference slope of 40 mL/yr (see
Section 10 and Section 8). This LLDr is used to identify excessive declines up to 8 years
of follow-up. Observations that fall below LLDr should be evaluated as to whether the
decline represents data quality issue or true decline. The turquoise (greenish-blue) dashed
line represents the American College of Occupational and Environmental Medicine
(ACOEM) longitudinal limit of decline calculated as LLD=Baseline FEV1×0.85years×30 mL/yr, based on 15% annual decline.10 The user can select the ACOEM limit
for decision-making by selecting LLDr of 15% and referential rate of decline of 30 mL/yr
as default. See Section 8 on instructions how to change the default options.
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Beginning with 4 years of follow-up, SPIROLA also tracks changes in the rate of FEV1
decline and displays this against the scale on the right axis. The brown dots show the
running rate of decline up to each data point and enable the user to discern the change in
the rate due to the last data point. The yellow dots show the running change in the slope
for the previous 8 years and enable the user to discern changes in the rate of decline in the
last 8 years. The three parallel lines represent 30, 60, and 90 mL/yr rates of decline.3
The bottom margin displays the linear Regression Slope and Within-person variation (sw)
for the individual who has 4 or more years of follow-up, and the mean Group Slope and
mean within-person variation Group sw, calculated as the averages of the individual linear
regression statistics.
Beginning with 8 years of follow-up, SPIROLA’s decision-making is based on the
estimated regression slope and the projected age when the regression (dashed green) line
crosses the 0.1th percentile (dashed yellow line). The blue dashed line shows the
longitudinal lower 95% confidence limit (CL) for the fitted regression line, estimated
from 8 years of follow-up data. This limit can be used to test whether the last observation
deviates significantly from the regression line predicted using all observations (Sections 9
and 10). To display the linear regression line extended beyond observed data, on the
Options menu click Display, Curves, General, and Show projected regression line as
shown below.

The table below the chart shows the individual’s demographic and lung function data at
each test date. Other data, for example name, weight, smoking status, cigarettes per day,
quality control data, and a technician’s code will be shown also if included in the
SPIROLA database (see Section 3.2).
SPIROLA Ver. 3.0.3
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Monitor FVC in an individual
1. On the Individual Evaluation menu click FVC Evaluation to show a FVC chart.
2. Click the arrow next to combo box (ID box) on the left bottom corner to select an ID.
Alternatively, type the ID into the Search for a Participant box on the Individual
Evaluation menu.

The individual FVC chart shows: the observed FVC values (green dots) plotted against
age; the linear regression line (green line) fitted to the observed FVC data (when at least
4 years of follow-up data are available); and cross-sectional lower limit of normal (LLN)
(purple line) and lower 0.1th percentile (yellow line) (comparable to 60% predicted),
based on U.S. population-based reference equations.9 Longitudinal limit LLDr (blue line)
is also provided. Individuals whose most recent measurements fall below LLDr or LLN
can be identified using the Risk List. The information should be evaluated as to whether
the decline represents data or spirometry quality issue or true decline.
Monitor percent predicted values in an individual
1. On the Individual Evaluation menu click Percent Predicted to obtain a chart with
percent predicted values for an individual person, as shown below.
2. Click the arrow next to combo box (ID box) on the left bottom corner to select an ID.
Alternatively, type the ID into the Search for a Participant box.
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Display summary report
1. On the Individual Evaluation menu click Summary Report to view results of an
individual’s data analysis and suggested course of action, as shown below (see
Section 9 on evaluation methods).
2. Click Print to print the Summary Report.
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Display multiple charts
1. On the Individual Evaluation menu click Multiple Charts and Chart Options.
Select charts to be displayed together, as shown below, and click Apply and Exit.

2. On the Individual Evaluation menu click Multiple Charts and View Charts to
display multiple charts, as shown below.
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Search for an individual by name or identity number
1. On Individual Evaluation menu click on Search for a Participant, as shown below.
2. Type the person’s name or identity number and click on Find Participant, or click
on Find Participant, to list all individuals. Select an individual and click Apply.
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Display data values and remove outliers on a chart
1. To display values on a chart, place the cursor on any data point, and then right click.
A small tooltip label will show coordinates.
2. To remove outliers, on the chart, place the cursor on any data point(s) which you
want to remove while processing the data, and then right click. The data point(s) will
be crossed out, and the regression line and other curves will be recalculated and
redrawn. To reload a data point, right click and include the observation in the
analysis. SPIROLA will remember the deletion and indicate it by a cross.
Note: The deleted data points are not deleted from the dataset and can be reinstated back
into the data analysis by clicking on the data point and including it in the data analysis.
To permanently correct data values, changes need to be done in the source database.

4.3 Group Evaluation Menu
Group evaluation menu (see below) helps the user to monitor over time the following
outcomes: group longitudinal FEV1 and FVC data variability (i.e., the pair-wise withinperson variation); group means for FEV1 and FVC; and the mean slopes of decline for
FEV1. All four charts can be displayed in one window in Multiple Charts. The group
evaluation can be done for all participants or for sub-groups identified by the Risk List
menu (i.e., those with abnormal spirometry findings or those selected for intervention).

Monitor longitudinal data precision in a group
1. On the Group Evaluation menu click on Within-person Variation for FEV1 or
FVC to show the yearly values of the pair-wise within-person variation sp (absolute)
and sr (relative), as shown below. The annual sp and sr values are calculated using
FEV1 or FVC measurements repeated within 18 months. The yellow numbers along
the bottom axis show the number of repeated observations used in the calculation;
only one pair-wise observation per person is included. If the number of repeated
observations is small (<50) in any one year, the sp and sr values are circled in yellow
to indicate that the estimate may not be reliable. The red horizontal line corresponds
to the desirable level of relative within-person variation of 4%. The legend at the
bottom of the screen shows the mean sp and sr values over all the year. These values
can be used to determine what longitudinal limit is appropriate (see Section 8.1:
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Define longitudinal limits for FEV1 or FVC). If spirometry is done less frequently,
the measure of average within-person variation can be obtained from Group Slope.
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Monitor mean FEV1 and FVC values in a group
1. On the Group Evaluations menu click Means for FEV1 (or FVC) to display yearly
group means for observed, predicted, and z-score (standard deviation units from the
predicted value) as shown below for FEV1.

The mean FEV1 chart shows group means for predicted (yellow), observed (green), and
z-score (red) values. Same applies for FVC chart. The predicted values are derived from
prediction equations that take into account age, height, sex, and race/ethnic background,
and are based on nationally representative healthy never-smokers.9 Irregular deviations of
observed mean values from predicted values may be due to changes in measurement
procedures, or due to effects of occupational exposure or interventions. Monitoring group
means can help to identify systematic effects taking place at a group level.
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Display multiple charts
1. On the Group Evaluations menu, click View Multiple Charts to display the three
group evaluation charts together (see example below). This allows the user to review
changes in a group FEV1 and FVC means in relation to data precision.

Display mean slope and within-person variation
1. On the Group Evaluations menu, click Group Slope to display the mean slope and
within-person variation for the group, for FEV1 and FVC. The mean statistics are
calculated from the regression analyses conducted on individuals who have four or
more years of spirometry follow-up.
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4.4 Print Menu
1. To print a current plot, click Print, or Quick Print on the Print menu.
2. Results summarized in a report can be printed as individual charts or in the Multiple
Chart option (see example below).
3. To preview the report, click Print Preview on the Print menu. Click one or two page
display on the upper picture menu, as shown below.
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4.5 Risk List Menu
The Risk List menu screens for individuals whose most recent lung function test results
are abnormal, or whose decline in lung function or variation in the longitudinal lung
function data are excessive. In addition, the menu enables to select individuals who have
been previously assigned an intervention plan. The subsequent lung function evaluation
can be done on both individual and group level. The group evaluation thus enables the
user to evaluate the effect of the various abnormalities, or interventions, on the group
mean lung function values (FEV1 and FVC). The group pairwise within-person may not
be as useful, unless spirometry is done on annual basis for a large number of individuals.
Screen for individuals at risk of developing respiratory impairment
1. On the Risk List menu, click Show Risk List Summary to obtain a list of
individuals whose rate of decline or within person variation in FEV1 or FVC has been
identified as excessive, or whose most recent lung function values (FEV1, FVC, or the
FEV1/FVC ratio) are below LLN. See figure below for the selection criteria.
2. The results from Risk List show the number of individuals screened and the numbers
with each type of outcome. Click on Print Summary to print the summary statistics.
3. To evaluate a subset of individuals with a specific outcome and/or with an
intervention plan, select the appropriate outcome(s) shown under Select Participants
With.
4. If the Intervention menu has been used to assign intervention plans, use the
Intervention Plans function to select individuals who were assigned an intervention
plan, or individuals whose plans were created from a specified data to the present
(i.e., current date).
5. Click on Select Participant(s) to select the individuals for evaluation. Alternatively,
to select a particular individual, scroll down the list, and click on a particular record
and on Select Participant(s). To see the lung function results without closing the
Risk List screen, click on the top blue frame of the Risk List and drag the screen to
the left bottom side and drag it up again when needed. If needed, click on Maximize
or Restore Down function at the top right corner of the Risk List screen to change the
size of the screen.
6. Click on Print List to print the list.
7. Click on Select Participant(s) and Exit to display lung function results and exit the
Risk List.
8. To exit from the Risk List click on Exit.
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Interpretation and suggested actions
1. Individuals’ lung function data evaluation
The tables below summaries “Result of the analysis” and “Interpretation and suggested
actions” as provided in the Summary Report. Individuals whose lung function is
categorized as abnormal based on the definitions below are selected into Risk List.
Cross-sectional evaluation using the most recent spirometry results
Result of the analysis
If any of the results below:
FEV1<LLN

FEV1/FVC<LLN
FEV1/FVC≥LLN and
FVC<LLN†
FEV1<0.1th percentile
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Interpretations and suggested action(s)
Examine spirometry quality and retest to confirm the results.
If confirmed that FEV1<LLN, the person has FEV1 value that has only
5% probability of being normal. If the results are confirmed, consider
further evaluation, more frequent testing, and intervention.
If confirmed that FEV1/FVC<LLN, results indicate airflow
obstruction. If the results are confirmed, consider further evaluation,
more frequent testing, and intervention.
If confirmed that FEV1/FVC≥LLN and FVC<LLN, results indicate a
low vital capacity. If the results are confirmed, consider further
evaluation, more frequent testing, and intervention.
If confirmed that FEV1<0.1th percentile, the person has FEV1 value
that has only 0.1% probability of being normal. If the results are
confirmed, consider referral for clinical evaluation, more frequent
testing, and intervention.
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Changes in FEV1 and FVC over time, with <8 years of follow-up
Result of the analysis
FEV1 or FVC <LLDr
Rate of decline in FEV1 and FVC

Within-person variation in FEV1
or FVC >5%

Interpretations and suggested action(s)
Examine the quality of baseline and current test. If confirmed that the
current FEV1 or FVC <LLDr, the rate of decline may be excessive.
Prior to 8 years of follow-up, excessive decline is evaluated using the
LLDr limit. The rate of decline is provided as additional information
from 4 years of follow-up, but is not used in SPIROLA’s decision
making.
The within-person variation >5% can be due to lack of spirometry
quality control. Consider correcting data errors before interpretation.
Occupational exposure, asthma, or personal factors can increase FEV1
variability.

Changes in FEV1 and FVC over time, with 8 or more years of follow-up
Result of the analysis
FEV1 or FVC values < 95%CL
(derived from the regression line)
Rate of decline FEV1 or FVC >90
mL/y.5
Within-person variation >5%

Projected FEV1 or FVC declines
to 0.1th percentile before 70 years
of age.

2.

Interpretations and suggested action(s)
If confirmed that FEV1 or FVC <95%CL for the regression line,
consider re-testing in near future.
If a rate decline in FEV1 or FVC >90 mL/y is confirmed, results
indicate excessive decline. Consider further evaluation, more frequent
testing, and intervention.
The within-person variation >5% can be due to lack of spirometry
quality control. Consider correcting data errors before interpretation.
Occupational exposure, asthma, or personal factors can increase FEV1
variability.
If projected FEV1 regression line declines to 0.1th percentile (≈60%
predicted), results indicate increased risk of developing moderate
impairment. If the results are confirmed, consider further evaluation,
more frequent testing, and intervention.

Group data evaluation

Users may also want to evaluate those selected into the Risk List at a group level.
1. To evaluate a group of individuals with a specific outcome, and/or individuals assigned
an intervention plan, in the Risk List select the appropriate outcome(s) shown under
Select Participants With.
2. Click Select Participant(s) and Exit.
3. Under the Group Selection menu select Participants in the Risk List, and then select
the desired chart from the Group Evaluation menu.
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Figure A

Figure B

This procedure allows the user to monitor group means for all participants as well as for
sub-groups selected into the Risk List based on various selection criteria. For example,
the two figures above compare trends for the mean FEV1 values for all participants
(Figure A) and for participants selected into the Risk List (Figure B). Notice those
selected into the Risk List have much lower observed mean FEV1 values (green line)
compared to predicted mean values (yellow line) than all participants.
Suggested Risk List evaluation procedure
The Risk List identifies individuals who fulfill any of the criteria listed in the above table
(see, Individuals’ lung function data evaluation). In addition, if the Intervention menu is
used to assign intervention plans, individuals with assigned plans can be also selected.
The following evaluation procedure is recommended.
1. Examination of the individual’s existing data
a. Examine the longitudinal demographic, FVC, and FEV1 data shown below the
FEV1 chart, to make sure that the data are reasonable.
b. If a data point appears to be an outlier, temporarily exclude the point by right
clicking on it and then evaluate the new results on the chart and in the report.
c. If a single data point appears to be an outlier and causes the individual’s selection
into the risk list, check for possible data errors. The first (baseline) observation
may sometimes be lower due to the learning effect. When this happens, exclusion
of the baseline value may improve precision of the interpretation.
d. If a data error is found, correct the data in the .mdb database using Microsoft
Access software, re-run SPIROLA, and review the new Summary Report.
2. Examination of the individual’s spirometry data quality
a. Examine the original spirometry tracings using the ATS standardization criteria
of: (a) acceptability (extrapolated volume, cough in first second, end of test
criteria, obstructed mouthpiece, extra breath, cessation of airflow); and (b)
repeatability (≤150 mL).9
b. If an acceptability error is found, consider removing data for that test from the
dataset, correct the SPIROLA .mdb file using Microsoft Access, and then re-run
SPIROLA to produce a new Summary Report for the individual.
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c. Provide feedback to the spirometry technician(s) on the spirometry errors found.
3. Re-test the individual
After the first two steps have been completed and SPIROLA still identifies the person as
being at risk, consider re-testing the person within six months from the most recent test.
If the re-tested spirometry values confirm the original interpretation, consider the
suggested actions in the new Summary Report.
Suggested intervention measures
When spirometry quality issues are satisfied and re-testing confirms that a person has
impairment or is at increased risk of developing respiratory disease, further clinical
evaluation, implementation of more frequent testing, and intervention measures should be
considered. The severity of existing impairment and the rate of lung function decline
should be considered when deciding on the type of intervention(s).
Interventions on an individual level:
Discussing lung function results with a worker can motivate the individual and can help
to determine what course of action is acceptable to the individual to prevent further
excessive lung function loss. Decreasing inhalation of noxious particulates and gases is
usually the most important intervention. The most important risk factor for excessive
decline in lung function is often tobacco smoking, for which nicotine replacement
therapy may provide best results for smoking cessation.10 Studies show that complete
smoking cessation is needed to halt excessive lung function decline.11 Occupational
exposures to respiratory hazards also represent an important risk.12 Evaluation of
individual occupational exposures should be done. Where possible, hazardous exposures
should be reduced or eliminated through engineering controls (e.g., substitution of less
hazardous materials, process enclosure, workplace ventilation). Administrative controls
(e.g., revised work practices) may also help limit hazardous occupational exposures.
Finally, use of effective personal protective equipment (e.g., respirators) should be
recommended when other measures are not feasible or insufficient by themselves. The
potential synergistic effect of smoking and occupational exposure on lung function
should be explained to individuals who are exposed to both hazards. Weight gain can also
contribute to lung function decline due to loss of fitness and difficulty in performing the
spirometry test at full lung capacity. Body mass index (BMI) greater than 25 kg/m2
associated with abdominal obesity can cause increased decline in lung function.
Interventions at a company level:
Management commitment to an integrated worksite health and safety program provides a
key foundation for success in maintaining a healthy workforce. Programs are likely to be
more effective when they are based on management’s understanding of workers’
concerns about health risks on the job. By identifying workers’ priorities, smoking (for
example) can be addressed in the broader context of worksite safety. Intervention at the
individual level is then more likely to be successful.
Evaluation of the effect of intervention(s):
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To determine the effect of individual intervention on the rate of FEV1 decline using
SPIROLA, use the small rate of decline chart shown on the FEV1 and FVC charts. To
determine the effect of an integrated worksite health and safety program using SPIROLA,
assess trends on the FEV1 and FVC means for the whole group and or at-risk subgroup.
The Intervention menu (Section 5) allows the provider to design an intervention
program for a group of workers, and to plan, record and evaluate an intervention for an
individual worker. The Questionnaire menu (Section 6) enables to conduct periodic
questionnaire surveys, and to integrate the questionnaire data with the spirometry and
intervention data.

5. Intervention Menu
The intervention and questionnaire modules have been created in collaboration with an
existing occupational safety and wellness program, to address the need of the program.16
Users can redesign the intervention or questionnaire forms using the design templates
provided in Sections 5.4 and 6.2, respectively.
The information created by the Intervention or Questionnaire modules is stored in the
administrative database SPIROLA_Admin.mdb. To avoid data loss, the administrative
database, as well as the spirometry database, should be kept in a secured location that is
regularly backed-up (see Section 9 on the administrative database management).

5.1 Tag Individuals for Spirometry Quality Control or Retesting
1. On the Intervention menu, click on Tag for Quality Control/Retesting.
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2. Add a new tag for Quality control or Re-Testing, this adds individual to a Tag List
(see below).

3. To display the Tag List, on the Intervention menu click on Tag List (see below).
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5.2 Setup and Evaluate Intervention Plan for Individuals
SPIROLA provides a generalized intervention plan which currently includes workplace
safety evaluation, lifestyle intervention, and disease management plan. Section 5.5
describes how to customize the intervention forms.
Setup intervention plan
1. On the Intervention menu, click on Intervention Setup to create an intervention
plan for an individual.
2. To develop the plan, check checkboxes under column Check (see picture below).
3. Click on Details, Plan Details, or Participants Plans buttons at the bottom of the
form, to view the current or previous plans, and complete the intervention plan setup.
4. Click on Save button to save the intervention plan in the administrative database.

Evaluate or modify interventions
1. On the Intervention menu, click Interventions List/Tickler to view interventions
set for an individual or a group of individuals (see below).

SPIROLA Ver. 3.0.3

31

2. On the Selected Intervention Plans section (see below), click on Details to view or
modify an intervention plan for an individual.
3. Use the Selection Criteria section and Select button to specify criteria (including
dates) to select a specific subset of intervention plans.
4. Use Delete function provided on each intervention plan record to delete an
intervention plan permanently.
5. To print the list of interventions, save the list to a .csv file and print from there.

5.3 Methods of Implementing Interventions
After intervention plans for individuals are setup by a healthcare provider using
Intervention Setup menu, the intervention forms can be completed using responses from
either: (i) participants; (ii) workplace safety officers; (iii) wellness coaches; or (iv) others
who are involved in the intervention program.
The information can be entered into SPIROLA using one of the following techniques:
1. Type answers directly into SPIROLA intervention forms. On Individual Evaluation
menu click on Search for a Participant to select an individual. Next, on
Intervention menu click Interventions List/Tickler to show the intervention plan(s)
created previously for the individual. Click on Detail and fill in the form.
2. Save an individual intervention plan and click on the Print Plan button. Print the
intervention plans (Safety or Lifestyle) and after the forms are completed, type the
answers into SPIROLA as above. Alternatively, the plans can be printed as a PDF file
and send by e-mail for completion.
3. Electronically (e.g., by e-mail), send batches of intervention plans to a worksite to
request safety assessment or to a wellness coach to request lifestyle assessment, and
to implement the intervention. The safety officers and wellness coaches use
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SPIROLA interface software to monitor the intervention. On completion, they send
the file back to the physician’s office to be read into SPIROLA (see below).

5.4 Electronic Safety or Lifestyle Assessment at Worksite
The section describes how to send electronically intervention plans to worksites or to
wellness coaches who then use SPIROLA interface software SPIROLA_Request to
implement the intervention. On completion, or at certain intervals, the responses are sent
back to the physician office to be read into SPIROLA for individual or group evaluation.
Creating safety or lifestyle assessment request
1. On the Intervention menu, click on Request Safety Assessment or Request
Lifestyle Assessment.
2. In the opened form (see below) click on Send Request Installation Package. Send
the self installing package SPIROLA_Request_Setup.msi to worksites or health
coaches. This needs to be done only once at the beginning.
3. To create an intervention request, fill the Description, Worksite, Plan Creation
Date From and Plan Creation Date To fields (see below). Use the button Worksites
at the top of the form, to create a list of worksites. SPIROLA will add only
intervention plans which were created between Creation Date From and Plan
Creation Date To inclusively.
4. Click on the Create button to save the safety assessment request or lifestyle
assessment request in the administrative database.
Note: Safety assessment requests include only intervention plans for which at least
one safety related question is checked (i.e., questions 1 through 6 in Intervention
Plan form). Lifestyle assessment requests include only intervention plans for which at
least one lifestyle related question was checked (i.e., questions 7 through 9 in
Intervention Plan form).
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Sending safety or lifestyle assessment request to worksite
1. On the List of Safety Assessment Requests (see picture above) click Send button
located next to a specific request. This opens an individual Safety Assessment
Request form to allow the user to prepare it for sending (see picture below).
2. To make changes to the request, use the Modify button to modify request settings
(including the dates), the Available Plans button to include intervention plan(s)
which were previously deleted or created after the request has been created, or the
Include column or the Remove button to exclude plans from a request but not the
administrative database.
3. Click on Send Request button to generate a file with the selected intervention plans.
4. Next, click on Save Request into Selected File to select an existing file name where
the request is to be saved. Alternatively, click on Save Request into a New File to
specify a new file name, and e-mail the file. The created file with SPREQ extension is
located in the directory where the administrative database is located, in folders
\SentRequests\SafetyRequests or \SentRequests\HealthyLifestyleRequests.
Alternatively, to find the location of the file, click on Open Default Folder.
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Completing safety or lifestyle assessment request at worksites
1. Install software called Spirola Worksite Assessment on a computer, if not already
installed, by clicking on the installation file
Spirola_Worksite_Assessment_Setup_V2.0.msi.
2. Double-click on the assessment request file (i.e., a file with SPREQ extension)
received from the physician’s office. If the file is not currently in a Spirola Worksite
Assessment’s default directory, a message shown below will be displayed.
3. Click on Save into Default Folder button, alternatively open from a current folder.

4. Spirola Worksite Assessment will open up with the list of intervention plans created
by the physician (see picture below).
5. Click on Details links, to implement an intervention plan. After completing an
intervention plan, check the checkbox in a column Is Completed (see picture above).
The checkboxes are reminders on which intervention plans have been completed.
6. After the intervention plans are completed, click on Send File button (see picture
above). SPIROLA Requests will open a directory which contains the file (i.e.,
SPREQ extension file) with completed intervention plans. Send the file back to the
physician’s office. This is the same file that was received from the physician’s office.
7. If Questionnaire to be Completed is marked as ‘Yes’, print a copy of a
questionnaire and ask a participant to complete it and send to the physician’s office.
Obtain the questionnaire PDF file from the physician’s office.
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Loading completed safety or lifestyle assessment requests to SPIROLA
1. Download a assessment request file (i.e., SPREQ extension file), received from a
worksite or health coach (e.g., e-mailed), into a directory.
2. Start SPIROLA and on the Intervention menu, click on Receive Assessment.
3. In the file dialog select an SPREQ extension file with received assessment.
4. In the opened form (see picture below) check the requests made and click on Load
Received Requests to Administrative Database. Intervention plans, for which
Include checkboxes are checked (see picture below), will be modified with data in
the received safety or lifestyle assessment request file (i.e., SPREQ extension file).
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5.5 Design Intervention Plan Template
SPIROLA allows modifying the intervention forms. Changes to the intervention forms
should be done at the planning stage of the intervention program. Changes made once the
data collection has started will make interpretation difficult. All changes made to the plan
template will be saved permanently in the administrative database, which needs to be
safeguarded and regularly backed-up (see Section 9).
1. To modify the intervention plan template, on the Intervention menu click on Print &
Design, and then click on Design Intervention.
2. In the form that opens next (see picture below) right click on a particular item (e.g.,
Mineral Dust) and select from the following menus:
• Click on Add Subcategory menu, to add new sub-question(s).
• Click on Add Checkboxes Table menu, to add checkboxes table.
• Click on Modify Category menu, to modify the text and characteristics of the
response. A form Category Schema Designer (displayed below) will appear and
allow the user to make desired changes.
• Note SPIROLA automatically generates unique value for the Variable Name
field, which identifies each question and is used when exporting intervention data
for use by other software. The name can be changed by the user, as discussed in
Section 5.6.

•

Click on Delete Category menu, to permanently delete a selected question and all
its sub-questions.
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•
•
•

Click on Copy Category menu, to copy the question, without copying the values
of the question.
Click on Copy Category and Subcategories menu, to copy question and all its
sub-questions, without copying the values.
Click on Select Parent Category menu, to highlight the parent question of the
selected question.

Create or modify choices of responses
SPIROLA allows creating or modifying choices of responses that can be used with each
question. To create or modify choices of responses do the following:
1. On the Intervention menu, click on Print & Design, and then on Design
Intervention.
2. In the opened form click on Customize Category Values at the top of the form.
3. In the form which opens next (see picture below), click on New Data Type, Modify,
or Delete buttons to create, modify, or delete the types of responses.
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For example if Modify button is clicked next to the Years: 1-4; 5-9; 10-19; 20 or
more item in the picture above, a form called Create/Modify Category Values will
open as shown in picture below, which can be used to modify or delete the choices.
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5.6 Export Intervention Data
SPIROLA provides a function for exporting intervention data stored in the administrative
database to a CSV file in a simple tabular format. The CSV file can be analyzed by
statistical software (e.g., SAS, SPSS) or opened by Microsoft Office Excel.
1. On the Intervention menu, click on Export Intervention Data and in the opened file
dialog (see picture below) select a directory and type a file name where the
intervention data should be saved.
SPIROLA creates two files: CSV extension file and XML extension file. For
example, if the user types Interventions.csv, SPIROLA will create files
Interventions Variables.xml and Interventions.csv in the selected directory.
a. CSV extension file (Interventions.csv in this example) includes all the
intervention plans in administrative database (i.e., a row per plan). The first row
contains variable names, and the following rows contain the values. Picture below
is an example of CSV file, opened using Microsoft Office Excel application.

Note, variable names V1, V2, V3, V4, V5, and V6 in this example are variable
names automatically assigned to questions in intervention plan by SPIROLA.
To change the variable name for a specific question:
• On Intervention menu click on Print & Design, and then on Design
Intervention. Next, right click on a question, and select Modify menu.
• In the form Category Schema Designer, which opens next (see picture
below), type a new variable name in the Variable Name field.
b. XML extension file (Interventions Variables.xml in this example) includes
information about variables, and the possible values of variables. This is a simple
text file, which can be viewed by Notepad application, which is included in
Windows 2000 or later (go to Start->All Programs->Accessories->Notepad to
open Notepad application), or by web browsers, such as Internet Explorer or
Firefox (i.e., normally this can be done by double clicking on the file).
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5.7 Manage Participants Menu
When the user tags participant for farther evaluation, or creates an intervention plan for a
participant (See sections 5.2), SPIROLA saves the intervention data in the administrative
database. To manage participants in the administrative database follow the steps below.
1. On the Intervention menu, click on Manage Participants. The form that opens next
(see picture below), lists all participants in the current spirometry database and
participants in administrative database.
Note, Manage Participants form allows creating and modifying participants’ data in
administrative database, but not in the spirometry database. Therefore, if a
participant’s data is modified using the Manage Participants form, the same
participant’s data should be modified in the spirometry database.
2. Click on button Create New Participant (see picture below) to create a new
participant in administrative database.
3. Click on a link in Id column (see picture below), to modify participant’s data in
administrative database.
4. Click on Delete button to delete a participant from the administrative database.
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SPIROLA highlights participants with duplicate IDs in yellow, and also allows filtering
out participants with duplicate IDs (i.e., click on Show Participants with Duplicate IDs
checkbox). Once participants with duplicate IDs are identified, they can be deleted.
SPIROLA will prompt if interventions and questionnaires, associated with the participant
being deleted should be deleted as well, or if they should be assigned to another
participant.
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6. Questionnaire Menu
The Questionnaire menu (see picture below) allows the user to design and manage
questionnaire surveys. The questionnaire forms are similar to the intervention forms
(Section 5) except that questionnaire includes a cover page (see below) to enable
electronic processing (i.e., scanning) of the questionnaires. The questionnaire design and
some of the details of the cover page can be customized.

Questionnaire cover page:
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6.1 View or modify questionnaires
1. On the Questionnaire menu, click on Questionnaires List/Tickler to view
questionnaires created for individuals (see picture below).
2. Click on Details links, to view or modify/fill in questionnaire.
3. Use section Selection Criteria and Select button, to specify selection criteria to be
applied to display a list of completed or to be completed questionnaires.
4. Click on New Questionnaire for ID: Id (see picture below) button to create
questionnaire for a participant, currently selected in SPIROLA, e.g., by using the
Individual Evaluation menu.

6.2 Design Questionnaire Template
SPIROLA allows the user to modify the default questionnaires template, similar to
designing the intervention plan template (see Section 5.5). Some details of the cover page
can be also modified. Changes to the templates are best done at the planning stage of the
intervention program. Changes made once the data collection has started will make
interpretation difficult. Changes made to the questionnaire template will be saved
permanently in the administrative database, which needs to be safeguarded.
Design questionnaire cover page
1. On the Questionnaire menu, click on Design Questionnaire.
2. In the form, that opens next (see picture below) select Cover Page Settings tab.
3. Right-click on a specific element on the cover page and select Properties menu.
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4. In the properties form, which opens next select the properties related to the selected
element. For example properties form for ID grid (see picture below) allows selecting
number of digits in participant ID and controlling the location of the grid on the page.
Note: Different elements have different properties, but usually the properties form
allows modifying element’s text (any language can be used) and element’s location.
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Design questionnaire questions
1. On the Questionnaire menu, click on Design Questionnaire.
2. In the next form (see picture below) select Questions tab.
3. Right-click on a specific question and select options to modify the question (see
picture below). Modifying questionnaire template is similar to modifying intervention
plan template, therefore refer to Section 5.5 for more details.
4. Once the questionnaire is designed, on the Questionnaire menu, click on Print.
5. Preview Blank Questionnaire to view how the questionnaire will look when printed.
Make sure that all questions fit within the bounding frame on the page.

Save blank questionnaire to PDF file
1. On the Questionnaire menu, click on Create PDF File with Blank Questionnaire.
2. In the dialog which opens next, specify a date, by which questionnaire should be
completed (by default, SPIROLA sets this date to six months from the current date)
and click on Ok button.
3. In the file dialog, which opens next select a directory where the PDF file should be
saved and type a name for the PDF file.

6.3 Perform Questionnaire Survey
The questionnaire responses can be typed into SPIROLA directly (see Section 6.1).
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Alternatively, SPIROLA allows electronic processing of the questionnaires by following
the steps below:
1. Save a blank questionnaire to a PDF file using SPIROLA (see Section 6.2).
2. Send the PDF file to worksites to be printed at worksites and to be distributed to
participants. Alternatively, the PDF file can be printed at physician’s office and sent
to worksites or participants. Note, the blank questionnaires should be printed on a
letter format paper (8.5’’ X 11’’ paper), which is a very common paper format.
3. Mail completed questionnaires back to the physician’s office. It is important that
participants mail unfolded questionnaires. Faxed questionnaires usually do not
produce good quality printouts and might have extra text added to the margins.
4. Scan the received questionnaires into one or several PDF files. If the number of
received questionnaires is large, scan the questionnaires into several PDF files (e.g.,
100 questionnaires per file). Note: A questionnaire cannot be split into two PDF files.
Important points to consider:
• The questionnaire template should not be modified after the survey has started and
until all the questionnaires are received from participants and loaded into SPIROLA.
If the questionnaire template is modified after questionnaires are received, the
answers should be typed into SPIROLA using the menu Questionnaire ->
Questionnaires List/Tickler explained in Section 6.1.
• The questionnaires should be printed on letter format (8.5’’ X 11’’ paper) and
scanned, using good quality printers and scanners.
• Participants should use black or blue ink pen to firmly fill the questionnaire circles.
Usually, crossing out the circles will work as well, but the reliability of data, parsed
by SPIROLA, will be the highest if the circles are filled in.
• Participants should not write anything outside the bounding frame.
• The pages scanned into the PDF file may be slightly rotated, but the horizontal and
vertical sides of the bounding frames should be perpendicular.
• The bounding frame, page numbers, and the symbols on the bottom of questionnaire
pages should be clearly visible.
The picture below is an example of a good quality questionnaire page in a PDF file,
which SPIROLA will successfully parse. The page is clean, boundaries are well aligned,
and the symbols at the bottom page are clearly visible.
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Check questionnaires for errors
SPIROLA enables the user to screen questionnaires for errors before loading the data into
the administrative database. The first step is to open the PDF file and check the
questionnaires for problems and try to fix these problems. Note, even if some
questionnaires are not successfully parsed, SPIROLA will process the rest of
questionnaires.
1. On the Questionnaire menu, click on Receive Completed Questionnaires.
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2. On the next form, click on File menu and Open PDF File with Questionnaires.
3. In the file dialog select the received PDF file with questionnaires. SPIROLA will
display the list of questionnaires in the PDF file (see picture below).
4. Click on Loaded Questionnaires tab, and select a questionnaire in the table on the
left side of the form. SPIROLA will show the details about the selected questionnaire,
in section Questionnaire Information on right side of the form (see picture below).
5. Click on Pages Loaded from PDF File tab (see picture below) to see the loaded
status of each page in the PDF file, as well as to fix errors (see second picture below).

6. Correct the errors. The two pictures (above and below) illustrate an example of
loading a PDF file with three questionnaires:
• The first questionnaire (i.e., questionnaire for participant with ID 150938) was not
successfully loaded, since SPIROLA found some errors on some pages of the
questionnaire (see the second picture above). To fix this problem user can select
the 5-th page and click on the button, with an arrow pointing down (see top-left
side of the form in the picture above). By doing this, the pages 5 and 6 will be
switched, after which the problems with questionnaire pages will be fixed.
• The second questionnaire pages were successfully loaded; however, Participant
ID box was not completed (see the first picture). To fill in the ID, click on Select
Participant from List and in the Select Participant form select a participant
John Smith, if this participant is listed in this form, or create a new participant
John Smith, by clicking on Create New Participant button in the opened form.
After these steps, the questionnaire will be assigned to a selected participant.
• The third questionnaire (ID 153973) was successful loaded.

SPIROLA Ver. 3.0.3

49

Note: SPIROLA uses red crosses, to show the checked checkboxes (see picture
above), that SPIROLA was able to identify in the PDF file. If the quality of
scanned questionnaire pages is bad, or if participant filled more than one
checkbox, then SPIROLA might interpret the data incorrectly. To make sure, that
invalid data is not saved into Administrative database, the user should click on
each page on the left side in picture above, and make corrections if necessary, by
clicking twice on the checkboxes that should be checked. In other words, the
selections originally identified by SPIROA can be changed by the user.
Note: When the selected page is blank or should not be considered as one of the
pages in questionnaire, the user should select Page data is ignored item in the
drop down list (see picture above). Also, if the page quality is bad and the
bounding frame could not be found by SPIROLA, then the user should select the
item User completes the page item in the drop down list and a page number in
the list Parsed page number (see picture above). SPIROLA will fail to find the
bounding frame in very rare situations.
Note: By default SPIROLA assumes that the circles on questionnaire pages are
firmly filled, when processing the data. If it is known that the printers and
scanners used to produce the loaded PDF file are of good quality, than SPIROLA
can be configured to correctly (in most cases) interpret selections on questionnaire
pages, when participants either firmly fill or cross out the circles. To do this, click
on Option menu and then on Questionnaire Loading, and in the opened form
select the appropriate setting (see picture below).
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Load questionnaires into SPIROLA
1. Questionnaires that have checkboxes under Check column checked, can be
transferred to the administrative database (the checkboxes are checked by default).

2. Click on Selected Survey link on the top-left side in picture above, and on the form
that opens next select a survey (see picture below), or create a new survey if
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necessary. After a survey is selected, click on Select button (see picture below), to
close the Questionnaire Surveys form.
Note: Surveys help organize questionnaires in several PDF file together. In other
words, once the questionnaires are loaded into SPIROLA administrative database, the
user can open different PDF file with questionnaires, and select the same survey. To
view or edit the questionnaires in a survey, click on Questionnaires button in
Questionnaire Surveys form (see picture below).

3. On the Load to SPIROLA menu (see second picture above) click on Load Selected
Questionnaires to SPIROLA Database to transfer the questionnaires to the
administrative database.

6.4 Export Questionnaire Survey Data
SPIROLA allows exporting questionnaire data from the administrative database to a CSV
file in a simple tabular format. The CSV file generated can be analyzed by statistical
software (e.g., SAS, SPSS) and by Microsoft Office Excel application.
1. On the Questionnaire menu, click on Export Questionnaire Data, and in the
opened file dialog select a directory, and type a file name, where the interventions
should be saved. Exporting questionnaires is similar to exporting intervention plans,
therefore refer to Section 5.6 for details.

6.5 Manage Participants Menu
To manage participants in administrative database refer to Section 5.7. When a
participant who is not currently in an administrative database fills in a questionnaire, the
name needs to be added into the database using this menu.
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7. Spirometry Quality Control Menu
1. On the Quality Control menu, click on Quality Control Indices, to obtain charts
that evaluate quality grades assigned from each test session by a spirometer. The
Quality Control charts are provided only if the quality grades are included in the
SPIROLA database (see Section 3.2). The example below is from an ongoing
monitoring program and shows: the percentage of FVC (green line, square symbol)
and FEV1 (green line, circle symbol) tests that meet the ATS/ERS acceptability and
repeatability criteria; the percentage of the tests that meet the ATS/ERS repeatability
criteria for FVC and FEV1 (blue lines); and the pair-wise within-person variation
based on tests repeated within 18 months. The chart can be also requested for
individual operators (see bottom of the following chart).
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8. Options Menu
The Option menu (see picture below) allows the user to change the following default
values:
1) The display on an individual’s chart
2) Longitudinal limits definitions for FEV1 and FVC
3) Cross-sectional limits – reference equations to be used

8.1 Display—Critical limit curves
1. On the Options menu, click Display, and then click Curves. A new dialog window
will appear, as shown below.
2. To enable or disable display of a critical limit curve for FEV1 or FVC charts, click the
check box next to the name of each critical limit curve. By default, all curves are
checked except Absolute LLD and Show projected regression line.
3. Click Apply to confirm the selections and Exit to exit this window.
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8.1 Define longitudinal limits for FEV1 or FVC
The Longitudinal Limits option allows changing definition of the longitudinal limits for
FEV1 and FVC, see below.

Click on FEV1 or FVC and the Referential Rate of Decline and Within-person
Variation options appear:

The Referential Rate of Decline option allows changing the default referential rate of
FEV1 decline of 40 mL/y used in the calculation of the limit of longitudinal decline
(LLDr). Studies indicate that the mean rate of FEV1 decline in healthy never-smokers is
about 30 mL/y. To achieve greater specificity of LLD for moderate impairment of lung
function, a referential rate of decline based on an average working population regardless
of smoking status, is used. For guidance, SPIROLA calculates the mean rate of decline
for the group using all individuals with four or more years of follow-up and shows the
result on the bottom margin of individual FEV1 and FVC charts. Using the mean rate of
decline as the referential rate of decline together with the program’s average withinperson variation will result in identifying about 5% of declines as excessive.5
The Within-person Variation option allows the user to change the value of the LLDr
limit used for decision making by SPIROLA. The default is based on the relative withinperson standard deviation sr of 4% which corresponds to LLDr of ≈10% for the first
year (see Section 10). This limit assumes relatively high longitudinal data precision.
When ATS/ERS recommendations on quality control are followed, workplace monitoring
programs can achieve comparable data precision.15
The ACOEM recommended longitudinal limit based on an annual decline of 15% can be
specified for decision-making be selecting a referential rate of decline of 30 mL/y and
within-person standard deviation of 6%.
To change the longitudinal limit LLDr that SPIROLA uses for decision making:
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1. Click Referential Rate of Decline and a dialog window will appear, as shown below.
Select a desired value from the list box, click Apply and Exit. To reset back to
default value of 40 ml/y, click on Reset to Defaults.

2. Click Within-person Variation, and then click Relative Value or Absolute Value
and a new dialog window will appear, as shown below.
3. Click the arrow button of Within-person standard deviation or Longitudinal limit,
and click on a desired value. If a desired value is not in the list box, enter the value.
4. Click the OK button to confirm the selection and Exit.

8.4 Cross-sectional evaluation—Customize reference equations
The Cross-sectional Limits and Reference Equations option allows the user to change
the reference equations to be used in the determination of whether the most recent FEV1
or FVC values are within the normal limits as determined by the reference equations. The
Height Option allows selection of the height values to be used in the reference
equations.
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1. Click Reference Equations to display a reference equations window (see below). By
default, SPIROLA uses U.S. population-based reference equations based on
NHANES III data.7
2. Select one of the following tab pages: US Reference Equations, European Reference
Equations, or Custom Reference Equations.

3. If Custom Reference Equations page is selected, user can customize the reference
equations, by typing into the table user-specific regression coefficients that
correspond to those provided in the equation above the table. If the equation does not
include some specific parameters (e.g., weight), let us know. If equations for some
race are not known, check the checkboxes above the table, to use US reference
equations for all individuals of specific race. For example if the setting for custom
reference equations are as shown below, SPIROLA will use custom reference
equations for all individuals with Caucasians and Mexican Americans, and SPIROLA
will use US Reference Equations for all African Americans.
4. Clock Ok and Exit to apply and save the new values
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The Cross-sectional Limits and Height Option allows to select whether the mean height
or the most recent height reported in the SPIROLA database for an individual is to be
used in the reference equations (see below).
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9. Administrative Database Management
Administrative database SPIROLA_Admin.mdb stores questionnaire results and
intervention plans (i.e., records created using the Intervention and Questionnaire
menus). To avoid data loss, the administrative database, as well as the spirometry
database, should be kept in a secured location that is regularly backed-up.
By default, when installing SPIROLA, the SPIROLA_Admin.mdb database is created
in the installation folder. Therefore, when installing or uninstalling SPIROLA, the user
should safeguard an existing SPIROLA_Admin.mdb database that contains
questionnaire or intervention data. This can be done by copying or moving
SPIROLA_Admin.mdb to another folder or by renaming the administrative database
(e.g., SPIROLA_Admin_Copy.mdb). When re-installing a SPIROLA V2.0 or higher, the
existing administrative database will be kept.
Note: the administrative database should be stored in a protected folder, so that only
authorized users have read/write permissions on the database file, since the database
might contain sensitive data.
1. To locate the current administrative database, on the File menu click on Select
Administrative Database. A window will inform the user of the current location of
the administrative database (see below).

2. To select a different administrative database, click on Locate Existing
Administrative Database button. For example, this function is useful when an
administrative database needs to be stored on a shared disk space or in a secured
location and all users need to point to it. To share administrative database:
a) Copy the existing administrative database into a shared folder using Window
Explorer.
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b) Click on Locate Existing Administrative Database button and select the copied
administrative database. Note: the located administrative database will became the
current administrative database.
3. To create a new administrative database, click on Create New Administrative
Database and select a new location and a file name for newly created administrative
database. Note: the created administrative database will become the current
administrative database, used by SPIROLA. Before creating a new administrative
database, SPIROLA prompts the user, if questionnaires and intervention plans
designed by the user should be migrated to the new administrative database (see
figure below).
c) If the user clicks on Yes button, the structure of questionnaires and intervention
plans designed by the user will be migrated to the new administrative database.
Individuals’ records (i.e., intervention plans and questionnaires related to specific
individuals), however will not be migrated to the new administrative database.
d) If the user clicks on No button, SPIROLA copies the default
SPIROLA_Admin.mdb file from the Template_Files under SPIROLA
installation folder into the specified folder. The new administrative database will
have general questionnaires and intervention plans, provided by SPIROLA.
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10. Theoretical Background
The use of SPIROLA may help to preserve lung function by:
(i)
Maintaining spirometry quality and longitudinal data precision at high level.
(ii)
Identifying individuals with excessive decline in lung function using limits of
longitudinal decline (LLDr) based on default criteria (i.e., sr=4% or LLDr=10%)
or the ACOEM longitudinal limit criteria (i.e., sr=6% or LLDr=15%);
(iii) Identifying individuals who already have lung function impairment using
ATS/ERS criteria based on cross-sectional data evaluation;
(iv)
Identifying when an individual’s lung function warrants individualized
intervention measures;
(v)
Evaluating the effects of intervention at the individual level and the group level.

10.1 Evaluation of FEV1 precision in a group
Monitoring a program’s data precision on an annual basis can help to identify and address
data quality problems soon after these occur and this way achieve and maintain high data
precision. To monitor data precision, SPIROLA calculates and charts yearly values of
the absolute within-person standard deviation sp and the relative within-person standard
deviation sr (see Section 4: Group Evaluation menu).4-6 These statistics are calculated on
a yearly basis as the difference between FEV11i and FEV12i measured within 18 months
of each other and summed over i = 1,..,n individuals. (Note: this is not within testing
session variance.) The year of the first measurement determines the assigned year. A
sample of about 50 individuals with repeated measurements is needed to obtain a reliable
estimate of yearly FEV1 variation.
The absolute within-person standard deviation sp for a specific year is defined as:

sp =

1 n
(FEV11i − FEV12i ) 2
∑
2n i =1

The relative within person standard deviation s r adjusts for each individual’s FEV1 size
and for a specific year is defined as:

1 n  FEV11i − FEV12i 

sr =
∑
2n i =1  (FEV11i + FEV12i ) / 2 

2

The average values sp = (1 / kN )∑ (s p n) and sr = (1 / kN )∑ (s r n) are calculated by
summing the yearly weighted s p and s r values over all years of follow-up and then
dividing by the total number of repeated observations N. These values represent the
average program-specific absolute and relative within-person variation, respectively. The
s p and s r values are shown at the bottom of SPIROLA’s Group Within-person Variation
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chart as ‘Mean s p ’ and ‘Mean s r ’. The mean within-person standard deviations sp and

sr can be used to derive the program-specific limits of longitudinal decline (LLD) by
substituting these for the default values on the Options menu under Within-person
Variation option. When annual measurements are not available, SPIROLA provides the
group average within-person variation Group sw estimated from the linear regression
analysis done on each individual’s data from 4 years of follow-up. Generally there is
good agreement between these two methods of estimation.
Note: If the sample of measurements repeated within 18 months is less than 50, the sp
and sr values are considered unreliable and are indicated by a yellow color. If sp and s r
values are not displayed or are based on a sparse sample, the user could use the default
LLDr value of 10% or change the default to LLDr of 15% as based on the ACOEM limit.

10.2 Estimation of limits of longitudinal decline for an individual
Because of inherent variability in the lung function data, it takes approximately 5-8 years
of follow-up to obtain a reliable estimate of the rate of decline in FEV1 or FVC in an
individual.4-6 To identify individuals with an excessive lung function decline within the
first 8 years of follow-up, SPIROLA uses by default the relative limit of longitudinal
decline (LLDr),6 but the absolute limit (LLDa) or the ACOEM limit based on 15% can
also be used. These limits are applied to determine whether the lung function decline
between the baseline FEV1 or FVC value (or a mean of the first two observations, if the
first value is lower than the second one) and each follow-up FEV1 or FVC is excessive.
Observations that fall below the LLD warrant concern. The absolute or relative
longitudinal limits are calculated using a default value based on 10% annual decline. The
user may change this to reflect the average within-person FEV1 variability for the group
or the ACOEM limit based on 15%.
The absolute limit of longitudinal decline LLDa (mL/yr) is defined as a one-sided 95%
confidence limit:
LLDa = t × (b +1.645×SE(b))
where t is the duration of follow-up in years and b is either the referent slope of decline
(up to 8 years of follow-up) or the individual’s estimated regression slope (beginning
with 8 years of follow-up). SPIROLA uses a default referent slope of decline of 40
mL/yr based on an analysis evaluating performance characteristics of the limit with
respect to sensitivity and specificity for long-term excessive decline in FEV1of >90
mL/yr and FEV1 <60% predicted. The standard error of the slope b is defined as
SE (b) = σ w 12( P − 1) / t P( P + 1)

(1)

where t is the duration of follow-up in years, P=2 represents two repeated measurements
done during the follow-up time t (the baseline and last observation), and σ w is the
within-person standard deviation. By substituting the program-specific pair-wise
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estimate of the within-person standard deviation sp for the within-person variation σ w in
equation (1), one can estimate program-specific absolute LLDa.
The relative limit of longitudinal decline LLDr (%) standardizes for the magnitude of
FEV1 and is defined as:
______

LLDr = t × (b/ FEV1b +1.645×SEr(b))

(2)

______

where FEV1b is the program-specific mean baseline FEV1, and SEr(b) is the approximate
______

standard error of b/ FEV1b calculated by substituting the program-specific relative
within-person standard deviation s r for σ w in equation (1).
The limit for the actual value of FEV1 (mL) below which an individual’s FEV1 should
not decline after t years of follow-up without raising concern can be calculated in terms
of the individual’s baseline FEV1b value and LLDa or LLDr, as follows:
FEV1 = FEV1b - LLDa or FEV1 = FEV1b - FEV1b ×LLDr
SPIROLA’s default value for the relative within-person variation s r is 4%, which
corresponds to LLDr of 10% for t=1 (i.e., annual follow-up). The LLDr of 15% for t=1,
which corresponds to the ACOEM limit, is based on s r of 6%. The longitudinal limit for
FVC is calculated in the same way. To change the default value, on the Options menu
use the Within-person Variation option. Beginning with 8 years of follow-up, the
interpretation of excessive decline is based on an individual’s regression slope and the
lower 95% confidence limit around the regression line calculated as above. Here b
represents the estimated regression slope and the individual’s baseline measurement
FEV1b is replaced by the individual’s predicted FEV1 value.
Cross-sectional evaluation to identify respiratory impairment
SPIROLA evaluates and reports for the most recent spirometry test whether the FEV1,
FVC, or FEV1/FVC ratio values are below the respective “cross-sectional” lower limit of
normal (LLN) values or whether the FEV1 value is below 0.1th percentile. This approach
defines the individual’s value in terms of the probability of being normal based on
population distribution for individual’s characteristics (i.e., age, height, gender, ethnicity
or race). By default, the LLN values and the predicted values are calculated using the
U.S. population-based reference equations estimated separately for Caucasians, AfricanAmericans, and Mexican-Americans.7 However, user-defined reference equations for
FEV1, FVC, and the FEV1/FVC ratio can be specified.

SPIROLA Ver. 3.0.3

63

11. References
1. Mannino DM, Reichert MM, Davis KJ. Lung function decline and outcomes in an
adult population. Am J Respir Crit Care Med 2006; 173:985-990.
2. Beeckman LA, Wang ML, Petsonk EL, et al. Rapid decline in FEV1 and subsequent
respiratory symptoms, illness, and mortality in coal miners in the United States. Am J
Respir Crit Care Med 2001; 163:633-639.
3. Sircar K, Hnizdo E, Petsonk E, Attfield M. Decline in lung function and mortality:
implication for medical monitoring. Occup Environ Med 2007; 64:461-466.
4. Baughman P, Marott JL, Lange P, Hnizdo E. Health Outcomes Associated with Lung
Function Decline and Respiratory Symptoms and Disease in a Community Cohort.
COPD: J of Chronic Obstructive Pulmonary Disease 2011: 48:103-113.
5. Baughman P, Marott JL, Lange P, Martin CJ, Shankar A, Petsonk EL, Hnizdo E.
Combined effect of lung function level and decline increases morbidity and mortality
risks. Eur J Epidemiology 2012;27:933-934.
6. Miller MR, Hankinson J, Brusasco V, et al. Standardization of spirometry. ATS/ERS
task force: Standardization of lung function testing. Ed. Brusasco V, Crapo R and
Viegi. Eur Respir J 2005; 26:319-338.
7. Hnizdo E, Yu L, Freyder L, Attfield M, Lefante J, Glindmeyer HW. Precision of
longitudinal lung function measurements—monitoring and interpretation. Occup
Environ Med 2005; 62:695-701.
8. Hnizdo E, Sircar K, Glindmeyer HW, Petsonk EL. Longitudinal limits of normal
decline in lung function in an individual. J Occup Environ Med 2006; 48:625-634.
9. Hnizdo E, Sircar K, Yan T, et al. Limits of longitudinal decline for the interpretation
of annual changes in FEV1 in individuals. Occup Environ Med 2007; 64:701-707.
10. Hankinson JL, Odencrantz JR, Fedan KB. Spirometric reference values from a
sample of the general U.S. population. Am J Respir Crit Care Med 1999;159:179-87.
11. ACOEM Position Statement: Evaluating Pulmonary Function Change Over Time in
the Occupational Setting. JOEM 2005; 47:1307-1316.
(http://www.acoem.org/guidelines.aspx?id=756)
12. Fiore MC, Bailey WC, Cohen SJ. Smoking cessation: clinical practice guideline No.
18. Rockville, MD: U.S. Dep. of Health and Human Services, Public Health Service,
Agency for Health Care Policy and Research. AHCPR Publication No. 96-0692.
13. Bohadana AB, Nilsson F, Westin A, et al. Smoking cessation—but not smoking
reduction—improves the annual decline in FEV1 in occupationally exposed workers.
Respir Med 2006; 100:1423-1430.
14. American Thoracic Society. Occupational contribution to the burden of airway
disease. Am J Respir Crit Care Med 2003; 167:787-797.
15. Hnizdo E, Tieliang Yan, Paul Enright, et al. Spirometry Longitudinal Data Analysis
software (SPIROLA) for analysis of spirometry data in workplace prevention or
COPD treatment. The Open Medical Informatics Journal; 2010: 4:94-102.
16. Hnizdo E, Glindmeyer HW, Petsonk EL. Workplace spirometry monitoring for
respiratory disease prevention: a method review. Int J Tuberc Lung Dis 2010:
14(7):796-805.
17. Hnizdo E, Hakobyan A, Fleming J, Beeckman-Wagner L. Spirometry-based medical
monitoring: spirometry quality vs. data precision. JOEM 2011; 53:1205-1209.

SPIROLA Ver. 3.0.3

64

18. Hnizdo E, Berry A, Hakobyan A, Beeckman-Wagner L-A, Catlett L. Worksite
wellness program for respiratory disease prevention in heavy construction workers.
JOEM, 2011:53:274-281.
19. Hnizdo E. The value of periodic spirometry for early recognition of long-term
excessive lung function decline in individuals. JOEM 2012.

Appendix A: Software requirements to run SPIROLA
•
•
•
•

Microsoft Windows XP/Vista/Windows 7/Windows 10
Microsoft .NET Framework 3.5 and Database engine. In most cases these software
packages are already installed on the user’s computer.
Microsoft Access 2003/2007/2010/2013 for viewing or editing data in Microsoft
Access format.
SPIROLA only supports 32-bit versions of Microsoft Office

If the .NET Framework version 3.5 redistributable package is not already installed on the
computer, it can be obtained as a free download and installed from the following
link: http://go.microsoft.com/fwlink/?linkid=118076
If you do not have Microsoft Access 2007 or a newer version installed, download and
install the 32-bit version of the Microsoft Access 2010 runtime from the following
link:
http://www.microsoft.com/en-us/download/details.aspx?id=10910
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Appendix B: Open different types of spirometry datasets
This appendix describes in more detail how to open different types of SPIROLA datasets.
To open SPIROLA dataset click on File menu and then on Open Database (see picture
below), and select one of the menu items: Open MS Access Database, Open ODBC
Database, or Open SQL Server Database.

Using the above menus, the following databases can be read into SPIROLA:
a) Open MS Access Database menu opens Microsoft Access database. In the file
dialog window that appears the user should select the desired .MDB extension file
(for example, DemoDataSet.mdb) and click Open to proceed.
i) If Connect to Database window appears the Microsoft Access database
might require a password that was assigned by the user, or an incorrect
Microsoft Access database has been selected. The .accdb file format requires
Access 2007 or newer. See Appendix A.
b) Open ODBC Database menu opens the following databases: Microsoft Excel files,
text files, SAS files, Oracle databases, MS Access database, MS SQL Server
databases, and other types of files and database supported by the ODBC system. If the
database to be opened is not a Microsoft Access database or Microsoft SQL Server
database use ODBC. Firstly, the user needs to create an ODBC data source (a link)
using instructions provided in Appendix E: Create ODBC data source for Excel 2007.
After the ODBC data source is created, select Open ODBC Database menu. In the
window shown below select a data source either from the User Data Sources or
System Data Sources lists and click on Connect button (some data sources might
require completing Login and Password fields). The created data source names
should appear in the list of sources.
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c) Open SQL Server Database menu opens Microsoft SQL Server database. Window
will appear as shown below. Type in the information provided by SQL Server
administrator. After all the necessary fields are completed, click on Connect button.
Note: Authentication field can have two values: Windows Authentication or SQL
Server Authentication. Authentication method to use will be determined by SQL
Server administrator, but using Windows Authentication simplifies things, since in
that case there is no need to complete Login and Password fields (SPIROLA uses the
login and password of the user currently logged into computer).
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Select data table or data provider and input options
1. In the window which opens next, click on a desired data table listed under Spirola
Tables as shown below (table Spirola_Full in this example).
2. Alternatively, if Spirola data provider is installed for the selected database, the user
can click on Spirola Data Providers tab and select a Spirola data provider for the
selected database (see picture below).
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Appendix C: Installing new Spirola data provider
1. On the File menu click on Open Database menu, and then on Open MS Access
Database.
2. Select any MS Access database, for example the file
SpirolaDataProviderDemo.mdb in SPIROLA installation folder.
3. In the form that opens next (see picture below) click on the Spirola Data Providers
tab, and then on button Open Home Directory, to open the directory, where Spirola
data provider files are saved.
4. Save the new data provider file (i.e., DLL or EXE extension file) to the directory
opened in Step 3.
5. If Spirola data provider file has dependent files, such as other DLL extension files or
image files, that the data provider is using, then do the following:
a) Create a new directory in the directory opened in Step 3, and rename the new
directory so that its name is similar to the Spirola data provider file name
without the extension.
For example if the Spirola data provider file name is MyDataProvider.dll, then
the new directory should have a name MyDataProvider
b) Copy the dependent files into the directory, created in Step a.
6. Restart Spirola.
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Appendix D: Note to .NET Developers on Programming
Spirola Data Provider
The steps below describe creating Spirola Data Provider using C#.NET and Visual Studio
2010. Other languages or compiles can be used as well, following these steps.
1. Install SPIROLA V3.0.3.
2. Start a Visual Studio 2010 and create a C# Class Library class project (project is
named MySpirolaDataProvider in this example).
3. Right click on References item in the created Visual Studio project (see picture
below), and in the menu click on Add Reference… menu.
4. In the window that opens next click on Browse tab, and select the file
SpirolaDataProviderBase.DLL from the folder, from the SPIROLA installation
directory (see picture below).

5. Create a class (named MyDataProvider in picture below) and do the following:
a) Add using SpirolaDataProviderBase and using SpirolaDataProviderBase.DB
statements, to be able to use classes in namespaces SpirolaDataProviderBase and
SpirolaDataProviderBase.DB in the referenced assembly
SpirolaDataProviderBase.DLL.
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b) Add a constructor to the created class, which does not require any arguments (see
picture below).
c) Make sure that class, created in Step 5 implements the interface
SpirolaDataProviderBase.ISpirolaDataProvider (see picture below). To
quickly implement the interface, right click on
SpirolaDataProviderBase.ISpirolaDataProvider text and click on Implement
Interface menu.

6. Click on Properties and then double-click on AssemblyInfo.cs file (see picture
below) and in the opened editor add line
[assembly: SpirolaDataProviderBase.SpirolaProviderClass(
"Type the full name of the class, which implements the interface
SpirolaDataProviderBase.ISpirolaDataProvider")]
In our example, the added line is:
[assembly:SpirolaDataProviderBase.SpirolaProviderClass(
"MySpirolaDataProvider.MyDataProvider")]
The full name of the class, which implements the interface
SpirolaDataProviderBase.ISpirolaDataProvider is
MySpirolaDataProvider.MyDataProvider in this example, therefore the added line in
this example should be
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[assembly:SpirolaDataProviderBase.SpirolaProviderClass(
"MySpirolaDataProvider.MyDataProvider")].

7. Compile the project to obtain the DLL file (MySpirolaDataProvider.dll in this
example), which should be copied to the special directory for installed Spirola data
providers, discussed in Appendix C above.
Note: File SpirolaDataProviderBase.DLL should not be copied, since this file is
already in SPIROLA installation directory.

For a complete example of programming Spirola data providers, refer to a directory
SpirolaDataProviderDemoSrc in SPIROLA installation directory. This directory
includes two zipped files:
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a) File SpirolaDataProviderDemo.zip, which includes source code for the
SpirolaDataProviderDemo.DLL demo Spirola Data Provider, which is
automatically installed with SPIROLA.
File SpirolaDataProviderBase.zip, which includes source code for the
SpirolaDataProviderBase.DLL assembly, which should be added to the list references
in Visual Studio project, when programming Spirola data provider (see Step 3 above).
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Appendix E: Create ODBC data source for Excel 2007
1) Click on the start button on the left bottom side of the screen and select Control
Panel (see picture below).

2) In the opened folder double-click on Administrative Tools (see picture below). In
the next opened window double-click on Data Sources (ODBC).

3) After a window called ODBC Data Source Administrator opens, select either User
DSN tab or System DSN tab and click on the Add button (see picture below).
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4) In the window called Create New Data Source that opens next scroll to Microsoft
Excel Driver and press the Finish button (see picture below)

5) Window called ODBC Microsoft Excel Setup will open next (see picture below).
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In this window:
• Type some name for the data source (e.g., Excel Data Source for SPIROLA).
• Click on the Select Workbook… button and select Microsoft Excel 2007 file
which has spirometry records in SPIROLA format (see Spirometry Database
Format in Section 3.2).
• Click on the Ok button.

Picture below shows an example of Microsoft Excel 2007 file, selected in ODBC
Microsoft Excel Setup window above (i.e., file C:\SPIROLA\SPIROLA_DB.xlsx) in
a required format.
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Appendix F: Starting SPIROLA from Third Party
Applications
Like any other Windows application, SPIROLA can be started from other software.
SPIROLA can be started in a normal mode (when all individuals’ test results in current
SPIROLA database are loaded), or in a single individual mode, when only test results for
specific individual are loaded.
To start SPIROLA in a single individual mode
1. Start SPIROLA and select a SPIROLA database on each computer, where SPIROLA
is installed (see Section 3.3 above). This step needs to be done only once, so that
SPIROLA remembers, from where to load the spirometry data the next time
SPIROLA starts.
SPIROLA stores the settings (including database settings) in app.config file under
some folder, which is specific to each Windows user. For example if currently
logged in Windows user is John, the app.config file on Windows XP system will
normally be stored in directory C:\Documents and Settings\John\Local
Settings\Application Data\SPIROLA. Therefore, to automate the Step 1, do Step 1
once, and copy the file C:\Documents and Settings\John\Local
Settings\Application Data\SPIROLA\ app.config to the appropriate directory on
each computer.
For example, app.config should be copied to directory C:\Documents and
Settings\John Smith\Local Settings\Application Data\SPIROLA, for the
windows user John Smith.
2. Start SPIROLA using a batch file (i.e., .bat extension text file), which has the
following line:
“C:\Program Files\Spirola\Spirola.exe” “ParticipantId=ID" .
Notes:
• Instead of using .BAT file, SPIROLA can be started programmatically
using VB Script or .NET language, as long as the parameter
“ParticipantId=ID" is specified, where ID should be replaced with some
individual’s identity number.
• Double parenthesizes may be omitted, as long as ParticipantId=ID text
does not contain any spaces.

SPIROLA Ver. 3.0.3

78

Appendix G: Import an Excel spreadsheet into the newly
created Access database using Microsoft Access 2003
•
•
•
•
•
•
•

•

•
•

From the File menu of Access, navigate to Get External Data and select Import.
Using the Files of type pull-down menu, select Microsoft Excel (*.xls).
Navigate to the file location of your formatted Excel file YourSpirometerData.xls,
select file, and click on the Import button.
Using the Import Spreadsheet Wizard, highlight the Show Worksheets radio button
and select the worksheet containing your spirometer data records; click Next >.
Check the “First Row Contains Column Headings” box and click Next >.
Since this is a new database, highlight the In a New Table button for the question of
where to store data and click Next >.
“Field Options Dialog Box”: Verify that field names and records follow the
formatting conventions described in the user manual on page 5; if not, field names
can be renamed here and data fields that are not being imported into dataset can be
excluded by checking the “Do not import field (skip)” box.
Indexed: If you have an ID field in your data sheet, choose “Yes (no duplicates)” for
that column. All other fields should be left with the default Indexed choice of No.
(Note- you will need to highlight each category to verify the selection.) When data
field verification is complete, click Next >.
In the “Import to Table” box, type the name “FullDataset” or “StandardDataset”;
click Finish and then OK to complete the import process.
Save and Exit Access
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Appendix H: Import an Excel spreadsheet into the newly
created Access database using Microsoft Access 2007
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Open newly created empty access database.
Click on the “External Data” tab.
Under the “Import & Link” section click on Excel.
The “Get External Data-Excel Spreadsheet” window will open.
Using the “Browse” button navigates to the Excel file you want to import.
In the “File Open” window select the file and click on the Open button.
You will return to the “Get External Data-Excel Spreadsheet” window.
Select the option “Append a copy of the records to the table”.
Select “FullDataset” or “StandardDataset” from the dropdown.
Click on the OK button.
The “Import Spreadsheet Wizard” will open and guide you through the steps
necessary to import the Excel spreadsheet.
Select “Spirola_Full” worksheet, if initial excel spreadsheet was created using
SPIROLA Empty database option otherwise select the worksheet that contains the
data and press Next>.
Check “First Row Contains Column Headings” check box.
In the “Import to Table” box, type the name “FullDataset” or
“StandardDataset”; click Finish and then OK to complete the import process.
Save and Exit Access
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